
 

 

 

 

 

 

 

 

ภาคผนวก 
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ภาคผนวก ก 

คู่มือการติดตั้งระบบคลงัข้อมูลงานด้านการรักษาผู้บาดเจ็บ ของศูนย์อุบัติเหตุ  

โรงพยาบาลมหาราชนครเชียงใหม่ 

 

 ในการพฒันาระบบคลงัขอ้มูลงานดา้นการรักษาผูบ้าดเจบ็ของศูนยอุ์บติัเหตุ โรงพยาบาล

มหาราชนครเชียงใหม่ ผูศึ้กษาใชโ้ปรแกรม Microsoft SQL Server 2008 R2 ซ่ึงมีขั้นตอนการติดตั้ง

โปรแกรมดงักล่าว ดงัน้ี 

1) เลือก Setup.exe ดงัรูป ก.1 

 

รูป ก.1 หนา้จอแสดงไฟล ์Setup.exe การติดตั้ง SQL Server 

2) แสดงขอ้ความยนืยนัการติดตั้ง เลือก OK ดงัรูป ก.2  

 

รูป ก.2 หนา้จอแสดงขอ้ความยนืยนัการติดตั้ง SQL Server 

3) เลือก I have read and ACCEPT the terms of the License Agreement และ คลิก 

Next ดงัรูป ก.3 
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รูป ก.3 หนา้จอแสดงขอ้ความยนืยนัการติดตั้ง .net framework 

 

4) ยนืยนัการติดตั้ง Framework เลือก Ignore ดงัรูป ก.4  

 

รูป ก.4 หนา้จอแสดงการยนืยนัการติดตั้ง Framework ในการติดตั้ง SQL Server 
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5) หนา้ต่าง Software Update Installation เลือก Next ดงัรูป ก.5 

 

รูป ก.5 หนา้จอแสดงขอ้ความยนืยนัการติดตั้ง SQL Server 

 

6) License Agreement เลือก I Agree และ Next ดงัรูป ก.6 

 

รูป ก.6 หนา้จอแสดง License Agreement ในการติดตั้ง SQL Server 
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7) เลือก Continue เพื่อยนืยนัการติดตั้งอีกคร้ังดงัรูป ก.7และรอโปรแกรมแสดงผลการ

ติดตั้งดงัรูป ก. 8 สกัครู่ 

 

รูป ก.7 เลือก Continue เพื่อยนืยนัการติดตั้งแบบLicense Agreement ในการติดตั้ง SQL Serverอีก

คร้ัง 

 

 

รูป ก.8หนา้จอแสดงผลการติดตั้ง SQL Server 

 

8) เลือก Finish เพื่อยนืยนัการติดตั้งในส่วนของ .Netframworkเรียบร้อย จากนั้นรอ

สกัครู่ จะปรากฏหนา้ต่าง เพือ่เลือกการติดตั้ง SQL 2008 เลือก OK (รูป ก.9) 
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รูป ก.9แสดงหนา้ต่างเพื่อเลือกการติดตั้ง SQL 2008 

 

9) SQL Server Installation Center เลือก Installation -> New SQL Server Stand-alone 

installation or add features to an existing installation ดงัรูป ก.10 

 

รูป ก.10หนา้จอแสดงSQL Server Installation Center 

 

10) หนา้ต่าง Setup Support Rules รอแสดงผลการติดตั้งสกัครู่ จนแสดงขอ้ความ OK 

ใหเ้ลือกไดด้งัรูป ก.11 หลงัจากนั้นโปรแกรมจะแสดงขอ้ความในการติดตั้งหนา้จอต่อไป รอสกัครู่ 

 

รูป ก.11หนา้จอแสดงหนา้ต่าง Setup Support Rules 
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11) กรอก Product Key -> Next ดงัรูป ก.12 

 

รูป ก.12หนา้จอส าหรับกรอก Product Key 

 

12) หนา้ต่าง License Terms เลือก I accept the license terms. เลือก Nextดงัรูป ก.13 

 

รูป ก.13หนา้จอแสดงหนา้ต่าง License Terms 

 



232 

 

13) หนา้ต่าง Setup Support Files เลือก Installดงัรูป ก.14 และเม่ือโปรแกรมท าการ

ติดตั้งเรียบร้อยแลว้จะแสดงปุ่ม Next ใหเ้ลือก ดงัรูป ก.15 จากนั้นตอบ OK โปรแกรมจะแสดง

ขอ้ความในการติดตั้งหนา้จอต่อไปรอสกัครู่ดงัรูป ก.16 

 

รูป ก.14แสดงหนา้ต่าง Setup Support Files 

 

 

รูป ก.15 แสดงผลเม่ือหนา้ต่าง Setup Support Files ท างานเรียบร้อย 
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รูป ก.16หนา้จอแสดงขอ้ความในการติดตั้งหนา้จอต่อไป 

 

14) หนา้ต่าง Feature Selection เร่ิมจากเลือก Features เพือ่ติดตั้งหากตอ้งการเปล่ียน 

Path เพื่อติดตั้ง SQL ใหก้ดท่ี Browser เพื่อเลือก Path ไดร์ฟ -> Select All -> Nextดงัรูป ก.17 

 

รูป ก.17แสดงหนา้ต่าง Feature Selection 

 

15) หนา้ต่าง Instance Configuration เลือก Named instance: และก าหนดช่ือของ SQL 

ท่ีตอ้งการใหม่เขา้ไป จากนั้นกด Next ดงัรูป ก.18 
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รูป ก.18หนา้ต่าง Instance Configuration 

 

16) แสดงหนา้ต่าง Disk Space Requirements เลือก Next ดงัรูป ก.19 

 

รูป ก.19แสดงหนา้ต่าง Disk Space Requirements 

 

17) หนา้ต่าง Server Configuration ในส่วนของ Account Name เลือกเป็น NT 

AUTHORITY\SYSTEM เพื่อมองท่ี System ระบบดงัรูป ก.20 จากนั้นกด Next 
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รูป ก.20แสดงหนา้ต่าง Server Configuration 

 

18) Database Engine Configuration 

(1) Authentication Mode เลือก Mixed Mode (SQL Server Authentication and 

Windows authentication) 

(2) Built-in SQL Server System ก าหนด password ของ sa 

(3) Specify SQL Server administrator กดท่ี Add Current User ระบบจะ Set ค่า

ตามเคร่ืองท่ีติดตั้งให ้จากนั้นกด Next ดงัรูป ก.21 

 

รูป ก.21แสดงวิธีการ Database Engine Configuration 
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19) หนา้ต่าง Analysis Service Configuration เลือก Add Current User จากนั้นกด Next 

ดงัรูป ก.22 

 

รูป ก.22แสดงหนา้ต่าง Analysis Service Configuration 

 

20) เลือก Install the native mode default configuration กด Next ดงัรูป ก.23 

 

รูป ก.23แสดงการเลือกInstall the native mode default configuration 
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21) Error and User Reporting กด Next ดงัรูป ก.24 

 

รูป ก.24แสดงหนา้ต่าง Error and User Reporting 

 

22) Installation Rules กด Nextดงัรูป ก.25 

 

รูป ก.25แสดงInstallation Rules ของการติดตั้ง SQL Server 
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23) หนา้ต่าง Ready to install กด Install ดงัรูป ก.26 

 

รูป ก.26แสดงหนา้ต่าง Ready to install 

 

24) Installation Progress โปรแกรมจะท าการติดตั้งระบบ เม่ือติดตั้งเสร็จเรียบร้อยแลว้

จะแสดงปุ่ม Next ใหก้ด ดงัรูป ก.27 

 

รูป ก.27แสดงหนา้จอโปรแกรมก าลงัท าการติดตั้งระบบ 
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25) เม่ือติดตั้งเรียบร้อยแลว้ ปุ่ม Next จะสามารถกดได ้ใหก้ด Next ดงัรูป ก.28 

 

รูป ก.28แสดงหนา้จอหลงัติดตั้ง SQL Server เรียบร้อย 

 

26) หนา้ต่าง Computer restart required ตอบ OK จากนั้นให ้Restart เคร่ืองเพื่อปิด 

Service การท างานของ SQL อีกคร้ัง (รูป ก.29) 

 
รูป ก.29แสดงหนา้ต่าง Computer restart required 



 
 

ภาคผนวก ข 

คู่มือการใช้งานระบบคลงัข้อมูลงานด้านการรักษาผู้บาดเจ็บ ของศูนย์อุบัติเหตุ  

โรงพยาบาลมหาราชนครเชียงใหม่  

 

 การใช้งานข้อมูลในระบบคลังข้อมูลงานด้านการรักษาผูบ้าดเจ็บ ของศูนย์อุบัติเหตุ 

โรงพยาบาลมหาราชนครเชียงใหม่แบ่งการใชง้านออกเป็นส่วน ๆ ดงัน้ี 

ข.1 การใชง้านเวบ็ส าหรับน าเสนอรายงาน 

ข.2 การสร้างรายงานดว้ย Microsoft Excel 

ข.3 การสร้างรายงานดว้ย Report Builder 

ข.4 การดึงโอนขอ้มูลดว้ย SQL Server Integration Service 

ข.5 การประมวลผลขอ้มูลดว้ย SQL Server Analysis Service 

 

ข.1 การใช้งานเว็บส าหรับน าเสนอรายงาน 

สามารถเขา้ไปท่ี http://sddn.med.cmu.ac.th ดงัรูป ข.1 ซ่ึงเป็นระบบตรวจสอบการเขา้ใช้

งานสมาชิกของระบบงานปัจจุบนัของศูนยอุ์บติัเหตุ จากนั้นใส่ช่ือผูเ้ขา้ใช้ระบบและรหัสผ่าน

ส าหรับการเขา้ใชร้ะบบบนัทึกขอ้มูลศูนยอุ์บติัเหตุ 

 
รูป ข.1 หนา้จอลอ็กอินเพื่อเขา้สู่ระบบคลงัขอ้มูลงานดา้นการรักษาผูบ้าดเจบ็ 
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โดยมีขั้นการเข้าใช้ระบบคลังข้อมูลงานด้านการรักษาผู ้บาดเจ็บของศูนย์อุบัติเหตุ 

โรงพยาบาลมหาราชนครเชียงใหม่ ดงัน้ี  

1) เม่ือท าการลอ็กอินเขา้สู่ระบบจากหนา้จอรูป ข.1 เรียบร้อยแลว้ ใหเ้ลือกเมนูInjury 

surveillance and Trauma Audit 

 

 
รูป ข.2 หนา้จอเมนูส าหรับเขา้สู่ระบบบนัทึกขอ้มูลศูนยอุ์บติัเหตุ 

  

2) เลือกเมนู Warehouse เพือ่เขา้สู่ระบบคลงัขอ้มูลงานการดา้นการรักษาผูบ้าดเจบ็ ฯ

(รูป ข.3)กจ็ะปรากฏหนา้จอหลกัดงัรูป ข.

4
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รูป ข.3 หนา้จอแสดงเมนูเพือ่เขา้สู่ระบบคลงัขอ้มูลงานการดา้นการรักษาผูบ้าดเจบ็ ฯ 

 
รูป ข. 4หนา้จอหลกัเวบ็ส าหรับน าเสนอรายงาน 

 

จากรูป ข.4 สามารถอธิบายรายละเอียดของเมนูหลกัได ้ดงัน้ี 

(1) เมนูโอนขอ้มูลเขา้สู่พื้นท่ีพกัขอ้มูล ประกอบดว้ย ชนิดของขอ้มูลท่ีตอ้งการ

โอน 3 ชนิด คือ ขอ้มูลผูป่้วยนอก ขอ้มูลผูป่้วยใน และขอ้มูลมิติ เม่ือเลือกชนิดขอ้มูลก็จะปรากฏ

รายการตารางท่ีสามารถเรียกโอนขอ้มูลไดด้งัรูป ข.5 

 
รูป ข.5 หนา้จอเมนูโอนขอ้มูลเขา้สู่พื้นท่ีพกัขอ้มูล 
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(2) เมนูรายงาน จะแสดงรายงานท่ีใชเ้ป็นประจ าและมีรูปแบบท่ีตายตวั รวมไปถึง

รายงานท่ีสร้างดว้ย Report Builder ท่ีผา่นการอนุญาตจากหัวหนา้ศูนยก์็จะมีการน ามาเช่ือมต่อกบั

หนา้จอน้ีดว้ยตวัอยา่งรายงานท่ีแสดงบนเวบ็แสดงดงัรูป ข.6 

 
รูป ข. 6หนา้จอรายงานท่ีดูผา่นเวบ็ของระบบคลงัขอ้มูลงานดา้นการรักษาผูบ้าดเจบ็ ฯ 

 

(3) เมนูสร้างรายงานดว้ย Microsoft Excel เม่ือคลิกท่ีเมนูจะเป็นการดาวน์โหลด

ไฟล ์Microsoft Excel ให้ผูใ้ชง้านเขา้ถึงโปรแกรม Microsoft Excel ไดเ้ร็วข้ึนนอกจากนั้นยงั

สามารถดาวน์โหลดคู่มือการใชง้านระบบได ้ดงัรูป ข.7 

 
รูป ข.7โปรแกรมMicrosoft Excelท่ีเลือกจากเวบ็ 
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(4)เมนูสร้างรายงานดว้ย Report Builder เม่ือคลิกเมนูจะเขา้สู่โปรแกรมReport 

Builder เพื่อสร้างรายงานส าหรับเตรียมน าไปเช่ือมต่อกบัระบบดูรายงานผา่นเวบ็ดงัรูป ข.8 

 
รูป ข.8การเขา้ถึงโปรแกรมReport Builder 

 

(5) เมนูคู่มือการใชง้านระบบเม่ือคลิกท่ีเมนูจะเป็นการดาวน์โหลดไฟลคู์่มือการใช้

งานระบบในรูปแบบไฟล ์Microsoft PowerPoint 

(6) เมนูจดัการรายงานส าหรับ เพิ่ม แก้ไข ลบ รายงาน รวมทั้ งหัวหน้าศูนยย์งั

สามารถจดัการสิทธ์ิการเขา้ถึงรายงานใหก้บัสมาชิกแต่ละกลุ่มได ้(รูป ข.9) 

 
รูป ข.9หนา้จอแสดงการจดัการรายงาน 
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(7) เมนูคน้หาขอ้มูลใน Cubeส าหรับ คน้หาขอ้มูลท่ีสนใจว่ามีรายละเอียดเป็นกลุ่ม

ขอ้มูลใด และเป็นมิติใหก้บัลูกบาศกว์ิเคราะห์เชิงมิติใดบา้ง (รูป ข.10) 

 
รูป ข. 10หนา้จอเมนูคน้หาขอ้มูลใน Cube 

 

(8) เมนูระบบบนัทึกขอ้มูล เม่ือคลิกเมนูน้ีจะน าเขา้สู่ระบบบนัทึกขอ้มูล ดงัรูป ข.2 

 

ข.2 การสร้างรายงานด้วย Microsoft Excel 

 การสร้างรายงานสารสนเทศดว้ยโปรแกรม Microsoft Excel นั้นผูใ้ชง้านสามารถเรียกใช้

โปรแกรม Microsoft Excel จากเคร่ืองคอมพิวเตอร์ของผูใ้ช ้และเช่ือมต่อขอ้มูลในลูกบาศก์

วิเคราะห์เชิงขอ้มูล (Cube) ไดโ้ดยตรง ซ่ึงมีขั้นตอนการเขา้ใชง้านดงัน้ี 

1) เปิดโปรแกรม Microsoft Excel 2007 หรือ 2010 ->เลือกเมนู Data -> From Other 

Source -> From Analysis Service ดงัรูป ข.11 
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รูป ข.11 หนา้จอการเช่ือมต่อขอ้มูลแบบลูกบาศกว์เิคราะห์เชิงมิติดว้ย Microsoft Excel 

 

2) พิมพช่ื์อเคร่ืองแม่ข่ายท่ีตอ้งการเช่ือมต่อ (Server name) และเลือกการลอ็กอินแบบ 

Use the following User Name and Password พร้อมทั้งใส่Username และ Password(รูป ข.12) 

 
รูป ข.12หนา้จอการเลือกเคร่ืองแม่ข่ายท่ีตอ้งการเช่ือมต่อ 
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3) เลือกฐานขอ้มูลลูกบาศกว์ิเคราะห์เชิงมิติท่ีสนใจ แลว้คลิกปุ่ม Next ดงัรูป ข.13 

 
รูป ข.13 หนา้จอการเลือกฐานขอ้มูลลูกบาศกว์ิเคราะห์เชิงมิติท่ีสนใจ 

 

4) เลือก Save password in file->Yes (เพื่อยนืยนัการบนัทึกรหสัผา่นไวก้บัไฟลง์าน) -

>Finishดงัรูป ข.14 

 
รูป ข.14 หนา้จอการSave Data Connection File and Finish 
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5) กรณีท่ีเคยมีการเช่ือมต่อขอ้มูลน้ีแลว้ระบบจะท าการถามว่าตอ้งการบนัทึกแทนท่ี

ไฟลเ์ดิมหรือไม่ ใหเ้ลือกปุ่มYesดงัรูป ข.15 

 
รูป ข.15 หนา้จอการแจง้เตือนวา่เคยมีการเช่ือมต่อขอ้มูลดงักล่าวแลว้ 

 

6) เลือกรูปแบบการแสดงขอ้มูลท่ีตอ้งการ และต าแหน่งท่ีจะให ้Pivot table แสดง(รูป 

ข.16) 

 
รูป ข.16 หนา้จอการเลือกรูปแบบและต าแหน่งส าหรับแสดงขอ้มูล 

 

7) ผลลพัธ์ท่ีไดห้ลงัจากการเช่ือมต่อส าเร็จ 

(1)บริเวณส าหรับแสดงขอ้มูล ซ่ึงจะมีอยู ่2 รูปแบบ คือ Pivot Table ใชส้ าหรับ

แสดงขอ้มูลเป็นตารางท่ีมีขอ้มูลไขวก้นัสองดา้น และ Pivot Chart ใชส้ าหรับแสดงขอ้มูลเป็นกราฟ 

ดงัรูป ข.17 
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รูป ข.17 หนา้จอบริเวณส าหรับแสดงขอ้มูล Pivot Tableและ Pivot Table 

 

(2)บริเวณส าหรับการเลือกใชข้อ้มูลเพื่อน าไปแสดงผลท่ีประกอบไปดว้ยขอ้มูล 4 

ประเภท คือ Report Filter ใชส้ าหรับขอ้มูลท่ีตอ้งการใชเ้ป็นตวักรองขอ้มูล Axis Fields 

(Categories) ใชส้ าหรับขอ้มูลท่ีตอ้งการใหแ้สดงเป็นแถว Legend Fields (Series) ใชส้ าหรับขอ้มูลท่ี

ตอ้งการใหแ้สดงเป็นคอลมัน์ และ Values ใชส้ าหรับแสดงขอ้มูลท่ีตอ้งการวดั ดงัรูป ข.18 

 
รูป ข.18 หนา้จอบริเวณส าหรับการเลือกใชข้อ้มูลเพื่อน าไปแสดงผล 
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8) กรณีท่ีสร้างรายงานสารสนเทศดว้ย Microsoft Excel จากไฟลแ์ม่แบบท่ีโหลดมา

จากเวบ็จะตอ้งมีการเปล่ียนค่า Data Source ใหม่ก่อนจึงจะใชง้านได ้ดงัน้ี 

(1) คลิกบริเวณขอ้มูล Pivot Table -> PivotTable Tools -> Options -> Change 

Data Source -> Change Data Source (รูป ข. 19) 

 
รูป ข. 19 หนา้จอวิธีเปล่ียน Data Source ของ Pivot Table 

 

(2) คลิกปุ่ม Choose Connection (รูป ข.20) 

 
รูป ข.20หนา้จอการเลือกการเช่ือมต่อแหล่งขอ้มูลใหม่ ของ Pivot Table 

 

(3) คลิกปุ่ม Browse for More… -> New Source (รูป ข.21) 

 

รูป ข.21หนา้จอแสดงวิธีการเลือก Data Source ใหม่ ของ Pivot Table 
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ข.3การสร้างรายงานสารสนเทศด้วย Report Builder 

1) เปิด Browser เขา้มาท่ี http://10.20.1.49/Reports และใส่ Username และ Password  -

>เลือก Report Builder จะไดผ้ลลพัธ์ดงัรูป ข.22 

 
รูป ข.22 หนา้จอแสดงหนา้หลกัของโปรแกรม Report Builder 

 

2) สร้าง New Project เร่ิมตน้จาก คลิก  -> New (รูป ข.23) 

 
รูป ข.23 หนา้จอสร้าง New Project ของโปรแกรม Report Builder 
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3) เลือกรูปแบบรายงานท่ีตอ้งการ (รูป ข.24) 

 
รูป ข.24 หนา้จอการเลือกรูปแบบรายงานท่ีตอ้งการของโปรแกรม Report Builder 

 

4) เลือก Dataset เพื่อสร้างกลุ่มขอ้มูลท่ีจะน าไปใชส้ร้างรายงาน ในกรณีน้ีจะเลือก 

Create a dataset -> Next ดงัรูป ข.25 

 
รูป ข.25 หนา้จอการเลือก Dataset ท่ีตอ้งการของโปรแกรม Report Builder 
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5) เลือก Data Source ท่ีตอ้งการเช่ือมต่อ ดงัรูป ข.26 

 
รูป ข.26 หนา้จอการเลือก Data Source ท่ีเคยสร้างไวข้องโปรแกรม Report Builder 

 

6) สร้าง Data Source Connections ใหม่ เลือก New… (รูป ข.27) 

 
รูป ข.27 หนา้จอการสร้าง Data Source ใหม่ ของโปรแกรม Report Builder 
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7) ตั้งช่ือ Data Source ใหม่ และเลือกประเภทการเช่ือมต่อ ในกรณีน้ีจะเลือกใช ้

Microsoft SQL Server Analysis Services -> OK ->Buildดงัรูป ข.28 

 
รูป ข.28 หนา้จอการตั้งช่ือ Data Source ใหม่ของโปรแกรม Report Builder 

 

8) ก าหนดค่าต่าง ๆ ในการเช่ือมต่อ Data Source -> OK (รูป ข.29) 

 
รูป ข.29ก าหนดค่าต่าง ๆ ในการเช่ือมต่อ Data Source ใหม่ของโปรแกรม Report Builder 
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9) หลงัจากกรอกรายละเอียดสามารถทดสอบการเช่ือมต่อไดโ้ดยคลิก Test Connection 

-> OK ดงัรูป ข.30 

 
รูป ข.30หนา้จอการทดสอบการเช่ือมต่อฐานขอ้มูลของโปรแกรม Report Builder 

 

10) หลงัจากนั้นกจ็ะมีขอ้ความปรากฏใน Connection string: -> OK รูป ข.31จากนั้น

เลือก Data Source Connection เรียบร้อยแลว้ คลิก Next 

 
รูป ข.31หนา้จอแสดง Connection string ของโปรแกรม Report Builder 

 

 

 

xx.xx
.xx 
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11) การสร้างรายงานผา่น Design a query มีรายละเอียด ดงัน้ี (รูป ข.32) 

 
รูป ข.32 หนา้จอแสดงรายงานของโปรแกรม Report Builder 

 

(1) Metadata จะแสดงรายละเอียดขอ้มูลท่ีสามารถน าไปสร้างรายงานได ้ซ่ึง มี 4 

ชนิด ไดแ้ก่ 

คือสญัลกัษณ์แทนขอ้มูลค่าท่ีตอ้งการวดั 

 คือ สัญลกัษณ์ แทนขอ้มูลมิติหรือมุมมอง 

คือ สัญลกัษณ์ แทนขอ้มูลมิติหรือมุมมองแบบปกติ 

คือ สญัลกัษณ์แทนขอ้มูลมิติเป็นล าดบัชั้น 

(2) บริเวณส าหรับลากขอ้มูลท่ีตอ้งการใชส้ าหรับกรองขอ้มูลในรายงานมาใส่ ดงั

รูป ข.33 

 
รูป ข.33หนา้จอบริเวณแสดงขอ้มูลท่ีใชเ้ป็นตวักรองขอ้มูลของโปรแกรม Report Builder 
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(3) บริเวณส าหรับลากขอ้มูลท่ีตอ้งการใชส้ าหรับแสดงในรายงานมาใส่ ดงัรูป ข.

34 

 
รูป ข.34หนา้จอบริเวณแสดงขอ้มูลท่ีใชโ้ชวใ์นรายงาน ของโปรแกรม Report Builder 

 

13) การใชง้านขอ้มูลส าหรับกรองขอ้มูลในรายงาน สามารถเลือกขอ้มูลตั้งตน้ในการ

กรอกได ้จากช่อง Filter Expression อีกทั้งยงัสามารถก าหนดใหแ้สดงเพื่อเป็นตวักรอกงขอ้มูลผา่น

หนา้รายงานจริงไดด้ว้ย -> Next ดงัรูป ข.35 

 
รูป ข.35หนา้จอแสดงการใชง้านการกรองขอ้มูล ของโปรแกรม Report Builder 
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14) การก าหนดขอ้มูลท่ีตอ้งการใหแ้สดงใน แถว คอลมัน์ และค่าท่ีตอ้งการวดั -> Next 

ดงัรูป ข.36 

 
รูป ข.36การก าหนดขอ้มูลท่ีตอ้งการใหแ้สดงใน แถว คอลมัน์ และค่าท่ีตอ้งการวดัในรายงาน 

 

15) การก าหนด layout ของรายงาน -> Next ดงัรูป ข.37 

 
รูป ข.37หนา้จอแสดงการการก าหนด layout ของรายงาน 
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16) การก าหนด Style ของรายงาน ->Finishดงัรูป ข.38 

 
รูป ข.38หนา้จอแสดงการก าหนด Style ของรายงาน 

17) การเขา้ดูผลลพัธ์ของการแสดงรายงานคลิก เพื่อดูดงัรูป ข.39-40 

 
รูป ข.39หนา้จอการเขา้ดูผลลพัธ์ของการแสดงรายงาน ของโปรแกรม Report Builder 
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รูป ข.40 หนา้จอแสดงผลลพัธ์ของรายงานของโปรแกรม Report Builder 

 

18) การสร้างกราฟ เร่ิมจาก เลือกเมนู Insert -> Chart -> Insert Chart ดงัรูป ข.41 

 
รูป ข.41หนา้จอการสร้างกราฟ ของโปรแกรม Report Builder 

 

19) เลือกประเภทของกราฟท่ีตอ้งการ ดงัรูป ข.42 

 
รูป ข.42หนา้จอการเลือกประเภทของกราฟ ของโปรแกรม Report Builder 
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20) จากนั้นก าหนดขอ้มูลท่ีแสดงใหก้บักราฟ ดงัรูป ข.43 

 
รูป ข.43หนา้จอการก าหนดขอ้มูลท่ีแสดงใหก้บักราฟ 

 

21) ตวัอยา่งรายงานท่ีไดจ้ากการสร้างดว้ยโปรแกรม Report Builder (รูป ข.44) 

 
รูป ข.44หนา้จอตวัอยา่งรายงานท่ีไดจ้ากการสร้างดว้ยโปรแกรม Report Builder 

 

22) จากนั้นผูดู้แลระบบกจ็ะท าการเขียนโปรแกรมเพื่อเช่ือมต่อระหวา่งหนา้ต่าง

รายงานสารสนเทศกบัรายงานท่ีสร้างข้ึนมาใหม่ 



262 

 

ข.3การดึงโอนข้อมูลด้วย SQL Server Integration Service 

 เป็นแพ็คเกจส าหรับดึงขอ้มูลของตารางขอ้เท็จจริงขอ้มูลอ่ืนๆ ของผูบ้าดเจ็บท่ีเป็นผูป่้วย

นอกซ่ึงมีขั้นตอนการสร้างดงัน้ี 

1) สร้าง SSIS Package พร้อมตั้งช่ือ tm_vn_ipd_other.dtsxและเช่ือมต่อแหล่งขอ้มูลตน้

ทางและปลายทาง (รูป ข.45) 

 
รูป ข.45 การเช่ือมต่อขอ้มูลตน้ทางและปลายของไฟล ์vn.dtsx 

 

(1) แหล่งขอ้มูลตน้ทาง คือ ระบบจดัการฐานขอ้มูลมายเอสคิวแอลของพื้นท่ีพกั

ขอ้มูลเร่ิมจาก คลิกขวาท่ีช่อง Connection Managers -> New ADO.NET Connection->เลือกOdbc 

Data Provider จากช่อง Provider ->เลือก Use user or system data source name: และพิมพช่ื์อ

เซิร์ฟเวอร์ของแหล่งขอ้มูลท่ีตอ้งการ ->คลิกปุ่ม Test Connection เพื่อทดสอบการเช่ือมต่อ ->หาก

เช่ือมต่อส าเร็จใหค้ลิกปุ่ม OK ดงัรูป ข.46 

 
รูป ข.46 การเช่ือมต่อระบบจดัการฐานขอ้มูลมายเอสคิวแอล 
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(2) แหล่งขอ้มูลปลายทาง คือ ฐานขอ้มูลSQL Server ในคลงัขอ้มูลเร่ิมตน้จาก คลิก

ขวาท่ีช่อง Connection Managers -> New OLE DB Connection ->เลือกเซิร์ฟเวอร์ของแหล่งขอ้มูล

ท่ีตอ้งการ ->เลือก Use Windows Authentication ->คลิกปุ่ม Test Connection เพื่อทดสอบการ

เช่ือมต่อ ->หากเช่ือมต่อส าเร็จใหค้ลิกปุ่ม OK ดงัรูป ข.47 

 
รูป ข.47 การเช่ือมต่อระบบจดัการฐานขอ้มูลเอสคิวแอล เซิร์ฟเวอร์ 

 

2) สร้าง Control Flow ท่ีประกอบไปดว้ย Execute SQL Task และ Data Flow Task ท่ี

เช่ือมโยงกนั และก าหนดรายละเอียดใน Execute SQL Task ดงัรูป ข.48 
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รูป ข.48 การก าหนดค่าใน SQLStatementของไฟล ์tm_vn_opd_other.dtsx 

 

3) Data Flow Task ช่ือ “tm_vn_ipd_other”ใชส้ าหรับก าหนดค่าการดึงขอ้มูลตาราง

วิเคราะห์ขอ้มูลดงัรูป ข.49 ซ่ึงมีจ านวน 6 ตาราง คือ  

(1) ตารางวิเคราะห์ขอ้มูลทัว่ไปของผูบ้าดเจบ็ท่ี Ward (f_ipd_vn)  

(2) ตารางวิเคราะห์รหสัโรค ICD10 ของผูบ้าดเจบ็ท่ี Ward (f_ipd_icd10)  

(3) ตารางวิเคราะห์รหสัโรค AIS90 ของผูบ้าดเจบ็ท่ี Ward (f_ipd_ais90)  

(4) ตารางวิเคราะห์การตรวจพิเศษและการตรวจทางรังสีท่ีท าใหผู้บ้าดเจ็บท่ี Ward 

(f_ipd_rad_all) 

(5) ตารางวิเคราะห์หตัถการท่ีท าใหผู้บ้าดเจบ็ท่ี Ward (f _ipd_etc_all) 

(6) ตารางวิเคราะห์ระยะเวลาการตามแพทยท่ี์ Ward (f_calldoc) 
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รูป ข.49 การก าหนดค่าการดึงขอ้มูลใน Control Flow ของไฟล ์tm_vn_opd_other.dtsx 

 

ข.4  การประมวลผลข้อมูลด้วย  SQL Server Analysis Service 

การประมวลผลข้อมูลลูกบาศก์วิ เคราะห์เชิงมิติข้อมูลทั่วไปของผู ้บาดเจ็บท่ี ERท่ี

ประกอบดว้ยขอ้มูลมิติจ านวน11กลุ่มขอ้มูล ไดแ้ก่ 

1) กลุ่มขอ้มูลการตรวจและวินิจฉยัผูบ้าดเจบ็ท่ี ER 

2) กลุ่มขอ้มูลค่าความรุนแรงของการเกิดอุบติัเหตุท่ี ER 

3) กลุ่มขอ้มูลการประเมินสญัญาณชีพแรกรับ 

4) กลุ่มขอ้มูลผลลพัธ์ทางการรักษาท่ี ER 

5) กลุ่มขอ้มูลวนัท่ีเขา้รับการรักษา 

6) กลุ่มขอ้มูลเวรการใหบ้ริการ 

7) กลุ่มขอ้มูลสาเหตุการเกิดอุบติัเหตุ 

8) กลุ่มขอ้มูลส่วนตวัผูบ้าดเจบ็ 

9) กลุ่มขอ้มูลสถานท่ีเกิดเหตุ 

10) กลุ่มขอ้มูลพฤติกรรมเส่ียงท่ีก่อใหเ้กิดอุบติัเหตุ 

11) กลุ่มขอ้มูลการน าส่งผูบ้าดเจบ็ 
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โดยจะตั้งลูกบาศกว์ิเคราะห์เชิงมิติช่ือ “SSAS_tm_opd_vn” ท่ีมีขั้นตอนการสร้างดงัต่อไปน้ี 

1) เรียกใชง้าน SQL Server Business Intelligence Development Studio ท าไดโ้ดยคลิก 

Start -> Programs -> Microsoft SQL Server 2008 R2 -> SQL Server Business Intelligence 

Development Studio ->คลิกเมนูFile ->New -> Project ดงัรูป ข.50 

 
รูป ข.50 การเรียกใชง้าน SQL Server Analysis Service 

 

2) เลือก Analysis Service Project ในช่อง templates ตั้งช่ือ Project ท่ีตอ้งการสร้าง 

และระบุไดเรกทอรีท่ีตอ้งการบนัทึกลงไปในช่อง Location แลว้คลิก OK จากนั้นจะแสดงหนา้จอ

การสร้าง Analysis Service ดงัรูป ข.51 

 
รูป ข.51 การก าหนด New Analysis ServicesProject 
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3) สร้าง Data Source เร่ิมจาก คลิกขวาโฟลเดอร์ Data Source-> New Data Sourceดงั

รูป ข.52 

 
รูป ข.52 การสร้างNew Data SourceในAnalysis ServicesProject 

 

(1)เม่ือหนา้จอ Data Source Wizard ปรากฏ ดงัรูป ข.53 ->Next 

 
รูป ข.53 หนา้จอData SourceWizardของAnalysis ServicesProject 

 

(2) เลือก Server name ท่ีเคยสร้างไว ้ดงัรูป 5.30หรือ สร้าง Server name ใหม่ โดย

การคลิดปุ่ม New (รูป ข.54) 
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รูป ข.54 การเลือก Server name ในData Source WizardของAnalysis Services Project 

 

(3) สร้าง Data Source ใหม่ โดยการคลิกปุ่ม Refresh เพื่อเลือก Server name อ่ืนๆ 

->เลือก Use Windows Authentication ->คลิกปุ่ม Test Connect (เพื่อเช็คการเช่ือมต่อว่าส าเร็จ

หรือไม่) -> คลิกปุ่ม OK ดงัรูป ข.55-> เลือก Use the service account ->คลิก Next -> ตั้งช่ือ Data 

Source -> คลิก Finish 

 
รูป ข.55 การเลือก Server name ในData Source WizardของAnalysis ServicesProject 
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4) สร้าง Data Source View  

(1) คลิกขวา ท่ีโฟลเดอร์Data Source View เลือก New Data Source View จะ

แสดงหนา้จอดงัรูป ข.56 

 
รูป ข.56 การสร้างNew Data SourceViewในAnalysis ServicesProject 

 

(2) เม่ือปรากฏหนา้จอ Data Source Wizard คลิกปุ่ม Next ดงัรูป ข.57 

 
รูป ข.57 หนา้จอ Data Source View Wizard ของ Analysis Services Project 
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(3) เลือก Data Sourceท่ีเคยสร้างไวด้งัรูป ข.58 

 
รูป ข.58 การเลือก Server name ในData Source WizardของAnalysis ServicesProject 

 

(4) เลือก Table ท่ีตอ้งการ ดงัรูป ข.59 -> คลิก Next ->ตั้งช่ือ Data Source View -> 

คลิก Finish 

 
รูป ข.59 การเลือก Table ท่ีตอ้งการน าไปสร้างลูกบาศก ์
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5) สร้าง Dimension  

(1) เร่ิมจาก คลิกขวาท่ีโฟลเดอร์Dimension เลือก New Dimension จะแสดง

หนา้จอดงัรูป ข.60 

 
รูป ข.60 การสร้างNew Dimension ในAnalysis ServicesProject 

 

(2) เม่ือปรากฏหนา้จอ Dimension Wizard คลิกปุ่ม Next ดงัรูป ข.61 

 
รูป ข.61 หนา้จอDimension WizardของAnalysis ServicesProject 
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(3) เลือก Dimensionท่ีตอ้งการสร้างดงัรูป ข.61 และคลิก Next 

 
รูป ข.62 การเลือกDimension ท่ีตอ้งการสร้างมิติหรือมุมมองในลูกบาศก ์

 

(4) เลือก Data Source View และตารางท่ีตอ้งการใชง้าน ดงัรูป ข.63 

 
รูป ข.63 การเลือก Data Source View และ Table ท่ีตอ้งการใชง้าน 
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(5) เลือก Related Tables และคลิก Next ดงัรูป ข.64 

 
รูป ข.64เลือกRelated Tables ของ Dimension 

 

(6) เลือกDimension Attributesและคลิก Next ดงัรูป ข.65-> ตั้งช่ือ Data Source 

View ->คลิก Finish 

 
 รูป ข.65การเลือก Dimension Attributes  
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(7) การก าหนดค่าใหก้บัขอ้มูลมิติ สามารถลากฟิลดข์อ้มูลจาก Data Source View 

มาแสดงไวใ้นส่วนของ Attributes เพื่อแสดงขอ้มูลดงักล่าวไวส้ าหรับสร้างรายงานในล าดบัต่อไป 

และยงัสามารถสร้างล าดับชั้นของได้โดยการลากขอ้มูลจากช่อง Attributes มาวางในช่อง 

Hierarchies ดงัแสดงในรูป ข.66 

 
รูป ข.66การก าหนดค่าใหก้บัขอ้มูลมิติ 

6) สร้าง Cube  

(1) เร่ิมจาก คลิกขวา ท่ีโฟลเดอร์Cube เลือก New Cube จะแสดงหนา้จอดงัรูป ข.

67 

 
รูป ข.67การสร้าง New Cube 

 

(2)เม่ือปรากฏหนา้จอ Cube Wizard ดงัรูป ข.68คลิกปุ่ม Next -> Next ->เลือก Use 

existing table -> Next 
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รูป ข.68การสร้างลูกบาศกเ์ชิงวิเคราะห์ดว้ย Cube Wizard 

 

(3) เลือกตารางท่ีตอ้งการใหเ้ป็นตารางขอ้เทจ็จริง->Next ดงัรูป ข.69 

 
รูป ข.69การตารางท่ีตอ้งการใหเ้ป็นตารางขอ้เทจ็จริง 
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(4) เลือกขอ้มลูท่ีตอ้งการวดั->คลิก Finishดงัรูป ข.70 

 
รูป ข.70การสร้างลูกบาศกเ์ชิงวิเคราะห์ดว้ย Cube Wizard 

 

(5) เลือกขอ้มูลท่ีตอ้งการสร้างมิติใหก้บัค่าท่ีตอ้งการวดั ->Next -> ตั้งช่ือใหก้บั

ลูกบาศกว์ิเคราะห์เชิงมิติ ->Finishดงัรูป ข.71 

 
รูป ข.71การสร้างลูกบาศกเ์ชิงวิเคราะห์ดว้ย Cube Wizard 
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7) การ Process ขอ้มูลท่ีเป็นมิติ และลูกบาศกว์ิเคราะห์เชิงมิติ เร่ิมตน้จาก เลือกขอ้มูลท่ี

ตอ้งการ Process ->คลิกขวาเลือก Process ดงัรูป ข.72 

 
รูป ข.72ขั้นตอนการProcess 

 

 



ภาคผนวก  ค 
ตัวอย่างแบบสอบถาม 

 
แบบสอบถาม 

การใช้งานระบบคลงัข้อมูลงานด้านการรักษาผู้บาดเจ็บ ของศูนย์อุบตัิเหตุ  
โรงพยาบาลมหาราชนครเชียงใหม่ส าหรับผู้บริหารศูนย์ ฯ เจ้าหน้าที่ธุรการศูนย์ ฯ และผู้ดูแลระบบ 

 
ค าช้ีแจง 

1. แบบสอบถามน้ีมีวตัถุประสงคเ์พื่อตอ้งการทราบผลของการใชง้านระบบการใชง้าน
ระบบคลงัขอ้มูลงานดา้นการรักษาผูบ้าดเจบ็ของศูนยอุ์บติัเหตุโรงพยาบาลมหาราชนคร
เชียงใหม่  และเพื่อเป็นพื้นฐานในการปรับปรุงและพฒันาระบบใหมี้ประสิทธิภาพต่อไป 

2. แบบสอบถามน้ีไม่มีผลกระทบต่อผูต้อบแบบสอบถามใดๆ 
 
ตอนที ่1 ประสิทธิภาพของการใชง้านระบบ 

โปรดพิจารณาขอ้ค าถามแลว้ท าเคร่ืองหมาย    ในช่องท่ีท่านเห็นวา่เป็นจริงท่ีสุด 
5 = ดีท่ีสุด, 4 = ดี, 3 = ปานกลาง, 2 = พอใช,้ 1 = ควรปรับปรุง 

รายการประเมิน 
ระดับความพงึพอใจ 

5 4 3 2 1 
1. ความสวยงามของการออกแบบหนา้จอ      
2. การเรียกดูขอ้มูลท าไดง่้ายและสะดวก      

3. ความถูกตอ้งในการประมวลผลขอ้มูล      
4. ความสมบูรณ์ของขอ้มูลท่ีมีอยูใ่นรายงาน      
5. ขอ้มูลสารสนเทศตรงตามความตอ้งการใชง้าน      
6.การน าเสนอขอ้มูลท่ีไดจ้ากระบบน าไปใชง้านต่อไดง่้ายและสะดวก      
7.ช่วยลดขั้นตอนการท างานท่ีเคยปฏิบติัอยูเ่ป็นประจ า      
8. การสร้างรายงานดว้ยตนเอง ท าไดง่้ายและสะดวก      
9.คู่มือการใชโ้ปรแกรมมีความชดัเจนและเขา้ใจง่าย      
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ตอนท่ี 2 ขอ้เสนอแนะและแนวทางในการปรับปรุงและพฒันาระบบ 
...............................................................................................................................................

.............................................................................................................................................................

.............................................................................................................................................................

.............................................................................................................................................................

.............................................................................................................................................................

................................................................ 
 

ขอขอบคุณท่ีใหค้วามร่วมมือในการตอบแบบสอบถาม 
 
เกณฑค์ าตอบในแบบสอบถาม แบ่งออกเป็น 5 ระดบั ดงัน้ี 

ดีท่ีสุด หมายถึง ผูต้อบแบบสอบถามเห็นวา่ค าถามนั้นตรงกบัความคิดเห็น “ดีท่ีสุด” 
ดี  หมายถึง ผูต้อบแบบสอบถามเห็นวา่ค าถามนั้นตรงกบัความคิดเห็น “ดี” 
ปานกลาง หมายถึง ผูต้อบแบบสอบถามเห็นวา่ค าถามนั้นตรงกบัความคิดเห็น “ปานกลาง” 
พอใช ้ หมายถึง ผูต้อบแบบสอบถามเห็นวา่ค าถามนั้นตรงกบัความคิดเห็น “พอใช”้ 
ควรปรับปรุงหมายถึง ผูต้อบแบบสอบถามเห็นวา่ค าถามนั้นตรงกบัความคิดเห็น “ควร

ปรับปรุง” 
 
 



 

 

ภาคผนวก  ง 
ตัวอย่างการเขยีนโปรแกรมในระบบโอนข้อมูล เข้าสู่พืน้ทีพ่กัข้อมูล 

 
 

ง.1 กระบวนการเพิม่ข้อมูลในพืน้ทีพ่กัข้อมูล 
เป็นกระบวนการเพิ่มขอ้มูลใหม่เขา้สู่พื้นท่ีพกัขอ้มูลโดยจะดึงขอ้มูลงานดา้นการรักษา

ผูบ้าดเจ็บทีละเดือนตามวนัท่ีผูบ้าดเจ็บเขา้มารับบริการการรักษาท่ีศูนยอุ์บติัเหตุ โรงพยาบาล
มหาราชนครเชียงใหม่มาท าการปรับปรุงให้อยู่ในรูปแบบตามท่ีออกแบบไวใ้นแบบจ าลองขอ้มูล
เชิงมิติ และตรวจสอบความถูกตอ้งก่อนการเพิ่มขอ้มูลเขา้สู่พื้นท่ีพกัขอ้มูล 
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รูป ง.1 ตวัอยา่งการเขียนโปรแกรมส าหรับกระบวนการเพิ่มขอ้มูลใหม่เขา้สู่พื้นท่ีพกัขอ้มูล 

ของไฟล ์insert_d_personal_main.php 
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ง.2 กระบวนการลบข้อมูลในพืน้ทีพ่กัข้อมูล 
ในการเคล่ือนยา้ยขอ้มูลเขา้สู่พื้นท่ีพกัขอ้มูลขอ้มูลทุกตารางควรเป็นขอ้มูลท่ีมีวนัท่ีเขา้รับ

บริการการรักษาเท่ากนัทุกตาราง เพื่อป้องกนัการเกิดความไม่สอดคลอ้งของขอ้มูล อีกทั้งผูดู้แล
ระบบจ าเป็นตอ้งท าการทดสอบระบบการเคล่ือนยา้ยขอ้มูลเขา้สู่พื้นท่ีพกัขอ้มูลว่ามีการตรวจสอบ
คุณภาพขอ้มูลไดถู้กตอ้งหรือไม่ จากการท างานท่ีกล่าวมาขา้งตน้ ผูศึ้กษาจึงจดัท าระบบส าหรับ
กระบวนการลบขอ้มูลในพื้นท่ีพกัขอ้มูล 

 

 
รูป ง.2 ตวัอยา่งการเขียนโปรแกรมส าหรับกระบวนการลบขอ้มูลในพื้นท่ีพกัขอ้มูล 

ของไฟล ์delete_table.php 
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